


1.1 Preface to the Extended
Second Edition

GIMP 2 for Photographers. In the meantime, the new GIMP 2.6 has

become available. Essentially, the subdivision in separate dialog boxes
has remained the same. However, there have been various modifications in
the segmentation and layout of the menu bars as well as in the appearance,
characteristics, and handling of windows. New tools and functions have
been added to the menus. Some tools offer new additional functions such
as scalable brushes and scalable options. In the future, the new graphics
library GEGL will be quite essential in enabling GIMP to operate with greater
color depth. That is to say that GIMP will be able to work with photos with
more color information than before. Also, the choice of the color palette
CMYK for printing in the four-color process will be available. However, the full
integration of these functions won't be available until the next one or two
versions.

This new edition of my book offers you a complete introduction into
photo and image editing with GIMP. | will explain the new functions in GIMP,
such as the new polygon lasso, the automatic free select tool, the healing
and repair brushes, and the perspective-cloning tool. | have also added
new chapters that will demonstrate the various techniques for correcting
over- and underexposed photographs and for brightening darker sections
of photographs and darkening brighter sections. This all will be illustrated in
detail, which includes the introduction of the corresponding programs and
plug-ins.

Theadditionsand updatesin GIMP 2.6 offer you an ever better opportunity
to master the enormous possibilities of digital image editing. | wish you lots
of fun learning these new techniques and putting your own ideas into action.

Klaus Goelker

Q good three years have passed since the first publication of my book



1.2 Introduction

If you are reading this book, you are probably interested in learning how
to touch up your digital photographs or create your own graphics or logos.
However, before investing hundreds of dollars on expensive software, you
may want to make sure that manipulating digital photographs is something
you truly enjoy.That's where GIMP 2.6—a free digital image editing program—
comes in. You most likely would like to learn how to use this free software to
improve your photographs.

This book is designed to facilitate your entry into the world of digital
image editing with the help of GIMP 2.6. Using hands-on examples, this book
will provide solutions to common problems encountered when editing digital
images. The instructions are structured in a step-by-step fashion. Each editing
tool and function of GIMP 2.6 will be explained in simple language. You will
learn the fundamentals of digital editing, familiarize yourself with common
image editing tools and their functions, and acquire a working knowledge of
the GIMP 2.6 program.

This book is not a reference guide for GIMP 2.6. It was created to provide
you with a set of “learning-by-doing” instructions that will explain how GIMP
works, what the program’s most important functions are, and how to easily
locate and use these tools.

Since GIMP was born of the Linux world, it is free. On the CD that
accompanies this book, you will find GIMP 2.6 along with several plug-ins
(add-ons) for the application. You'll also find copies of the sample images used
in the exercises contained in this book.

Digital image editing programs often seem more complex than the more
common software programs, such as word processors. Sometimes you must
perform a number of preparatory steps before you can see a result on the
computer screen. However, if you're experienced with computers, certain
commands should be familiar to you.

Whether you're aWindows, Linux, or a Mac OS user, GIMP works essentially
the same way, with the exception of the installation process. GIMP is often
distributed with Linux. If you use Windows or Mac OS, you will have to install
the program. This book will show you how.

Once you have explored GIMP and learned how to use it, you may not
need—nor want—to buy another image editing program. If you do decide
to migrate to another program, you will have to familiarize yourself with a
new interface. However, you'll quickly discover that the basic commands,



()

functions, and tools of alternative digital imaging software programs are
similar to those of GIMP 2.6 in more ways than you might think.

GIMP 2.6 also contains a built-in help system. In addition, there are many
existing books about the software, including several free online texts. Please
refer to this book’s appendix for a list of references regarding GIMP.

GIMP is an acronym for GNU Image Manipulation Program. GIMP was bred
from the Linux world and is an open-source software program covered by the
General Public License (GPL). GNU means “GNU’s Not Unix” and refers to a
collection of software based on the UNIX operating system and maintained
by the Free Software Foundation.

GIMP is “the Photoshop of the Linux world"—it is the best free image
editing program. GIMP 2.6 was introduced in October 2008. This enhanced
version of GIMP meets the functionality requirements of even the most
exacting digital photographer. Its interface is highly efficient and easy to use
once you know your way around.

In fact, the book you are reading right now was created using GIMP
version 2.6.2 (released in October 2008). From the point of view of the user,
there have been no changes yet up to version 2.6.8 in January 2010. So for all
general purposes, this book is current.

GIMP’s primary function is to create and edit pixel or bitmap images, but it also
can be used for other tasks. The program will help you touch up your digital
photographs, create digital art, or author a new logo for your company’s web
page. And that’s just the tip of the iceberg.

Vector graphics programs are often used to create original or complex
images and/or animations. GIMP supports some basic vector graphic features.
You can draw an image using the GFIG plug-in and the Path tool. However, you
should be aware that GIMP was not designed to be a designated environment
for creating and editing complex vector diagrams.

GAP stands for GIMP Animation Package, and with it GIMP offers a range
of useful tools for creating small animations on a frame-by-frame basis. For
example, you can use GIMP’s GAP package to read or write AVI- and GIF-
formatted videos and animations. You can also use GAP to open and read
videos in MPEG format.
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1.3 Introduction to Digital Image Editing

1.3.1 Characteristics of Pixel Images

GIMP is used primarily for editing pixel or bitmap images. Pixel images are
made up of tiny dots called pixels; these images are somewhat like mosaics in
structure. All photographic images captured by a digital camera or copied by
a scanner are pixel images. The pixel image is considered standard.
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Figure 1.1
The image dots (pixels) become visible when a pixel image is overly enlarged.

Size and resolution are the most important characteristics to take into
account when manipulating pixel images. Since pixel images are composed
of tiny dots, it can sometimes be tricky to enlarge them. If you overdo it, the
individual dots will become visible and the photograph will lose its integrity.

The size and resolution of an image also determines the file size (i.e.,
storage volume measured by kilobyte or megabyte) of any given image.
Uncompressed pixel images normally result in very large file sizes.




Comparing pixel and vector images
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The manner in which you can edit an image is influenced by the structure
of its pixels. Basically, each image dot can be edited in terms of brightness and
color. GIMP 2.6 supplies appropriate and easy-to-use tools for editing single
dots as well as groups of dots.

When you make a general change to a pixel image, usually the whole
image will be affected. Therefore, if you wish to manipulate only a specific
area of an image, you should use a selection tool to designate that area. You
may even want to cut a desired selection from the image so you can work
with layers (transparent “foils” containing distinct image objects that can be
manipulated separately and are layered one on top of the other).

Selections, masks, and layers are advanced tools that are provided by
image editing programs like GIMP for detail work. These topics will be dealt
with extensively in the hands-on exercises that follow.

In contrast to pixel images, vector graphics are used when creating
original graphics and logos. Rather than editing image pixels, you can use
vectors to create novel image elements. Vector images are made up of lines,
curves, circles, rectangles, and fills. The size of each of these elements can be
scaled; the contour can be filled with color or gradients. For graphics, this is
less data intensive. Vector or contour shapes can also be selected and edited
individually. At any time, you can tweak the shape or change the color of a
fill. However, this requires another type of image editing program, a so-called
vector graphics program. For instance, Inkscape is the best-known free, open
source vector graphics program (http://www.inkscape.org/). Commercial
programs for this type of graphics work are Corel Draw and Adobe lllustrator.

You should know: Vector graphics are almost boundlessly scalable.

However: Editing vector graphics images requires different techniques
and specifications than editing pixel images.

Bottom line: Photos and other pixel images can be converted to vector
graphics only in an extremely simplified form, and sometimes not at all.

You can add a text or graphic elements to pixel images. These are also
displayed using pixels, but they have a disturbing element. For example, the
edges of the letters appear serrated. This is called aliasing. Anti-aliasing is a
countermeasure used to smooth the border of the pixilated, and therefore
serrated, letters. Anti-aliasing adds pixels at the border of a letter, which are
colored in the color of the text, but fading to transparency. In this way, a kind
of blending is achieved. The edges of the letters lose definition and appear
smoother (see figure 1.3d).

You can smooth the edges of pixilated graphic elements by choosing
the feathered edges. Feathered edges of selections will be dealt with in great
detail later in the book.
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Pixel images are rectangular images made up of little squares made up of
image dots, or pixels. The density of the dots contained in any given pixel
image is called its resolution. Resolution is normally measured in dots per inch
(dpi). In the metric system, dpi is the number of dots per 2.54 centimeters. You
can also refer to an image’s resolution in pixels per centimeters (the standard
measurement in most European four-color printing companies). Although
dpi seems to calculate only the length or width of an image, changing the
resolution of an image will influence its height as well. For example, doubling
the resolution of an image will result in a fourfold increase of the number of
pixels.

An image’s size (the dimension in inches, millimeters, or pixels) is directly
dependent on its resolution. If you transform an image with a resolution of
300 dpi to a resolution of 72 dpi using GIMP, the image size (width x height)
increases more than fourfold, even though without interpolation the number
of image dots remains the same.

300 dpi will produce an image of quality resolution. 300 dpi is
recommended for a scanned image, especially if you intend to edit and print
the image at a 1:1 scale.

Ifyouwanttoenlargeanimage, you'llwantto scanitatahigherresolution.
As a rule of the thumb, if you plan to double the image size (width or height),
scan at twice the resolution desired for the final image. If you simply want to
reduce an image’s dimensions, the visible image quality will usually stay the
same or get better, so you need not worry about increasing it.

Four-color printing uses various standard resolutions (e.g., 150, 300,
600, or 1200 dpi). These are indicative values.

Images on the Internet often use lower resolutions, mostly 72 or 96
dpi, values that correspond to the standard resolution of PC monitors. A low
resolution keeps the file sizes of images small enough for the images to be
efficiently and quickly transmitted over the Internet. Low-resolution images
will still yield good-quality printouts on inkjet printers.

Bottom line: A higher resolution (i.e., higher quantity of finer dots) will
result in an excellent image that can be enlarged to a certain extent without
compromising quality. On the other hand, if you reduce the resolution of
an image without reducing its dimensions, the image quality will drop. It is
important to make a copy of the original image when experimenting with size
and resolution because the process cannot be reversed.
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1.3.3 Screen Colors — Color Models and
GEGL, the New Graphics Library

GIMP’s version 2.6 employs three color models: RGB (red, green, blue),
grayscale, and indexed.

GIMP uses the RGB colors, or colors of light, as its default. Together,
these colors form what is known as the additive color model. It uses the
three primary colors—red, green, and blue—to create a color spectrum
containing approximately 16.78 million colors. This is called true color because
it represents the maximum number of colors that a computer monitor or
television screen can display.

Mixing two primary colors in RGB mode will result in the creation of a
secondary color, such as yellow, cyan, and magenta. No color (or the absence
of light) creates black, while the sum of all colors results in white.

Figure 1.4 Figure 1.5

The RGB color model The color spectrum of the RGB color model.
About 16.78 colors are shown, with black at
one extreme and white at the other.

Figure 1.6 Figure 1.7
Approximated representation of the set There are 256 gray levels in the RGB color
of colors in the RGB color model model.
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If you wish to specify a color for a printer or want to choose a unique
background color for your web page, the following information should be
considered.

Specific colors correlate to unique numerical values. In the RGB color
model, each of the primary colors (red, green, and blue) has a decimal color
value ranging from 0 to 255, with black as 0 and white as 255. Hence, there
are 256 color values for each of the base colors red, green, and blue. The
total number of potentially resulting colors is calculated by the following
multiplication:

256 « 256+ 256 =16.777.216 colors

To specify the number of colors of an image or color model, | use the term
color depth, which is specified in bits. The RGB color model has a color
depth of 24 bits (24-bits = 2 to the power of 24 colors = 16,78 million
colors)

These values apply to color as well as black-and-white images. In the world
of digital image editing, black-and-white photographs are called grayscale
images. In addition to the black and white “colors’, grayscale images contain
all possible shades of neutral gray.

Since the color values of the three primary colors must be identical in
order to produce purely gray levels, the number of gray “color”values amounts
to 256.

Grayscale images have a color depth of 8 bits.

In the RGB color model, the colors are normally defined in decimal
numbers. As mentioned earlier, each single color can have a value between
0 and 255. You can use the eyedropper icon located in the Toolbox of GIMP to
open the Color Picker to measure a color. The Color Picker will show you the
number corresponding to a color’s exact value so you can easily transmit the
information to your colleagues or work partners.

Black 0

Red 0

Green 255 0

Blue 0 255

255 0

Cyan 255 255

Magenta 0 255

Medium gray 128 128

White 255 255 255

The primary and secondary (mixed) colors in decimal notation

LL
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Ifyouwanttoappropriateacolorfromanexistingimageasthe background
color for a web page, you will need to specify hexadecimal numbers (base
16). Convert the decimal numbers (see above) into hexadecimal numbers,
which are simply denoted by adding a # symbol in front of the number. You
can use any tool for this conversion, including the Windows Calculator (Start >
Programs > Accessories > Calculator > View > Scientific).

GIMP conveniently performs this conversion for you. Its Color Picker tool
will provide you with the hexadecimal number value for every color.

Many image file formats used on the Internet use indexed colors rather than
RGB. Indexed colorimages don't save the color values in the pixels themselves,
but add a defined color palette. The number of colors in this indexed color
palette is limited to 256. Indexed images are usually smaller than RGB images
since they possess a color depth of 8 bits instead of 24 bits. When an image
is converted to indexed color, a predefined color palette or a set of colors
derived from the image itself will automatically be formulated. The palette
can contain a maximum of 256 colors. File formats that automatically create
images with their own color palettes include the compressed GIF format
as well as the 8-bit PNG format. Indexed images can also include gray-level
images (with a maximum of 256 shades of gray).

However, you may find using an indexed palette cumbersome because
it won't allow you to access all of GIMP’s editing options. Indexed images
are normally edited in RGB mode. After editing, the indexed palette can be
selected and attached to the image before saving and exporting the file for
use on the Internet.

Digital pre-press in four-color printing uses the CMYK color model. The
CMYK model behaves quite differently than the RGB model. For one thing,
CMYK has four color channels rather than three like RGB, so the nominal
number of colors increases in CMYK. Nevertheless, the color range of CMYK is
smaller than RGB. Thus, when you convert an image from RGB to CMYK, it may
appear paler or darker due to the loss of image information or the insertion
of additional black. To avoid fading or darkening, edit your image in the RGB
mode before converting it to CMYK mode. Also, because changes often result
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when shifting modes, you should avoid converting an image from RGB to
CMYK, and vice versa, unless it is necessary.

Since the CMYK color model has four color channels, it possesses a total
number of approximately 4.3 billion potential colors, which translates to a
color depth of 32 bits.

The colors of this model are subtractive primary colors. This means
that the CMYK model behaves inversely to the RGB model. For example, if
you apply the RGB model to CMYK, then 256 shares of cyan, 256 shares of
magenta, and 256 shares of yellow should produce black. However, what you
will actually see is a dirty dark brown. To obtain real gray and black shades,
you have to add black. CMYK s actually an acronym for Cyan, Magenta, Yellow,
Key, where Key = Black.

Currently, GIMP does not have a feature for converting and editing images
directly in CMYK mode. However, it can produce the chromatic components
necessary for use in four-color printing processes. If you want to edit in CMYK,
you can use the Image > Mode > Decompose menu command to decompose
your image into the four color channels. Each of these channels can then be
saved, edited, and shared as separate images, which can be re-integrated
prior to printing.

Alastair M. Robinson’s plug-in Separate+ offers a feature for color
separation as well as additional features for soft proofing and duotone
coloration. You can find information about the plug-in on the author’s website:
http://www.blackfiveservices.co.uk/separate.shtml. The improved version can
be found at http://registry.gimp.org/node/471 and on the DVD at the back of
the book.

After the installation, you will be able to separate an image into the four
color channels of the CMYK color model by using the menu command Image
> Separate. The separate channels will be generated as layers in a new picture
and can be retouched individually.

At least GIMP can separate the colors for the four-color printing by using
grayscale images from one image.

Note: Further information on plug-ins can be found in section 1.5.2. You
can find the download addresses in the link list on DVD. Most of the mentioned
plug-ins are gathered there as installable files.



When saving an image, you should select a file format that corresponds to the
requirements of the image as well as your stylistic intentions. This section will
introduce you to the most commonly used file formats.

GIMP’s XCF format was created for the primary purpose of saving images with
layers; however, it can also be used to save images that aren't finished yet. The
XCF format saves image layers by employing a lossless compression method. So
the file size of an XCF formatted image will be smaller than most other image
file formats and about 30 percent smaller than the PSD format, described later.

Since overly large files are cumbersome and can be unmanageable,
GIMP’s native XCF format is the best choice for storing images with layers. The
only drawback of GIMP’s current version is that XCF files cannot be opened in
another image editing program. If you want to export an XCF file into another
program, you must first convert a copy of it into JPEG, PNG, or TIF. If you plan
to consistently use other programs in conjunction with GIMP 2.6, you should
save images with layers in the PSD format.

XCF Characteristics

. 16.78 million colors, 24-bit color depth

«  Alpha transparency (color gradient from transparent to opaque)
+  Lossless compression

+  Supports layers

PSD (PhotoShop Document) is the native file format of Adobe Photoshop, one
of the most popular image editing programs. This file format is considered
a de-facto standard and can be used by almost all other image editing
programs, including GIMP. It is a high-quality format that is frequently used to
export images with layers.

The downside of saving images in PSD is that the files are often quite
large because the format provides no compression options.

Since GIMP 2.4, Photoshop layer masks are readable, and it can even write
in the PSD format. However, GIMP does not support some PSD formats such
as smart objects or smart filters.

PSD Characteristics

« 16.78 million colors, 24-bit color depth
+  Alpha transparency (color gradient from transparent to opaque)
+  Supports layers
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The PNG format is capable of preserving the transparencies of an image with
full 24-bit color depth. Moreover, it uses a high lossless compression method
that considerably reduces the image file size.

The PNG format is also suitable for Internet use.

PNG Characteristics

« 256 or 16.78 million colors, 8- or 24-bit color depth

«  Alpha transparency (color gradient from transparent to opaque)
«  Lossless, settable compression

«  Suitable for the Internet

. Interlaced (immediate display, layered refresh rate in web pages)

Photographs and photo-realistic images with a color depth of 24 bits can
be efficiently compressed with the JPEG format, which reduces image files
to a fraction of the original size. However, the compression method used by
the JPEG format is not lossless. This means that the image quality will suffer
in correlation with the degree of the compression as well as the decrease in
file size. The JPEG format was developed primarily as a way to quickly load
photographs on the Internet. JPEG format should be avoided when archiving
digital photographs. You should also refrain from repeatedly saving an image
in the JPEG format because the quality of your image will drop with each
subsequent save. To preserve the integrity of your images, use the PNG format
to save when you are working with them and to archive your images after
you've finished editing them.

For exporting images in the JPEG format, GIMP offers a programmable
compression option with a preview feature. This option will display the file
size of the compressed photo prior to saving it.

JPG Characteristics

« 16.78 million colors, 24-bit color depth

«  High but lossy compression; settable by the user

«  Suitable for use on the Internet

«  Progressive (faster display in Web pages, layered image refresh rate,
comparable with the interlaced characteristic




Unlike other file formats, the GIF format requires a color palette. This means
that a maximum of 256 colors can be saved in conjunction with an image.
GIMP can create these color palettes automatically, but there is a major
drawback to doing so. Converting images with an original color depth of 24
bits (or more) to GIF will usually produce an unsatisfactory result.

However, if you save an image with 256 or fewer colors (such as a simple
logo) to GIF, the GIF compression is lossless. In addition, GIF files allow you to
save one transparent color as well as simple animations (animated GIF).

The GIF format is often used to upload images to the Internet

GIF Characteristics

+ 210256 colors, 8-bit color depth (at least one, possibly transparent, color)
+  Lossless compression for images containing up to 256 colors

»  Suitable for use on the Internet

+  One color can be transparent

« Interlaced (immediate display, layered refresh rate in web pages)

+  Animated GIF available

Microsoft developed BMP, therefore it is supported by most Windows image
editing programs and is a suitable format for image sharing between different
programs. BMP has a color depth of 24 bits and the image resolution remains
unchanged when exporting. However, because the size of BMP files is normally
quite large, the format is not particularly suitable for the Internet.

BMP Characteristics

. 16.78 million colors, 24-bit color depth
«  Rather unsuitable for use on the Internet (for Microsoft Internet Explorer
only)
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This is one of the oldest image file formats still in use. Almost all image editing
programs can read and write a TIF formatted image, even if they're being run
on different operating systems. For this reason, it is the best file format to use
when sharing high-quality images without layers. Basically, the file format
also allows you to save images in the CMYK mode for the four-color printing
process.

The TIF format preserves all transparencies of an image with the full color
depth of 24 bits. It uses a lossless, but not particularly high, compression
method. With an adapted TIF format, you may save images with the 48-bit
color depth (i.e, HDRI images). The major drawback of using TIF is that it
doesn't support layers (except in Adobe Photoshop).

TIF Characteristics

« 16.78 million colors, 24-bit color depth

«  Alpha transparency (color gradient from transparent to opaque)

+  Lossless LZW compression

- Different settings for saving when used on IBM/Intel and Macintosh
PowerPC computers

Adobe’s DNG format was developed to replace the proprietary RAW files and
create an open standard. It offers advantages in the long-term archiving of
RAW files and provides photographers with a certain amount of freedom from
the camera’s own software. GIMP’S plug-in UFRaw can work with DNG and
most cameras’ RAW formats. Several camera manufacturers have introduced
this format to save images in their cameras.





